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1. Introduction 

 
Welcome to Climsoft version 4 Data transfer guide. This guide will instruct you on how to 
import data from different sources into Climsoft. It will also show you how to migrate your data 
from the earlier versions of clmsoft to Climsoft version 4. There are two (2) types of data 
transfer operations in Climsoft version 4: 
 

1) Internal Data Transfer Operations; 
2) External Data Transfer Operations 

2. Internal Data Transfer Operations 

 
These operations includes the upload of data from data entry forms to observationinitial table 
where the quality control is performed and the transfer of data from the observationinitial table 
to observationfinal table.  
 
All data-entry forms have got an “Upload” button (green) for transferring data from the key-
entry form table to a common table named “observationInitial” where more Quality Control 
(QC) checks are carried out. 
 
Note: This button is not enabled for a user with the role of operator, but is enabled for users 
with the role of operator supervisor, QC and administrator (Figure1). 
 

 
Figure1 - Initiate the Transfer of data from the data entry form to observationInitial via 
the Upload button 
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When the upload button clicked, it will display the dialog below where the user specify the 
data for which Stations and the period range (Begin Year, End Year, Begin Month and End 
Month) of data to be transferred from the selected data entry form to the observationInitial 
table. After selecting the start button data transfer process will start immediately and the 
progress will be displayed at the progress bar. 
 

 
Figure2 - Uploading data from the data entry form to observationInitial via the Start 
button 
 
Once data has been successfully transferred into "observationInitial table", the quality 
control is performed and when finished, data will then be transferred to "observationFinal 
table". 

 

Important 

 It should be noted that only data that would have gone through QC will be uploaded to the 
“observationFinal” table. Observation records that have not been QC’d will have a QC status 
zero “0” (qcStatus=0) while records that have been QC’d will have a QC status one “1” 
(qcStatus=1). 

 

Follow the steps below to transfer data from observationInitial table to observationFinal 
table: 

Step1: Login into Climsoft with the role of "Quality control" or "Operator supervisor" or 
"administrator"; 
Step 2: Click on "Data transfer" icon located on the welcome form; 
Step 3: Click on "Upload" then select "Obs Initial to Final" (Figure3); 
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Figure3 - Initiate data transfer processing from the observationInitial to the 
observationFinal 
 
Step 4: Select “Obs Initial to Final” to open the dialog below (Figure 4) and fill the form with 
the details of the stations, elements and period range of data you want to transfer (Begin year, 
End year, Begin Month and End Month) and click on the "Upload" button to start the process 
of transferring your data to "observationFinal table" (Figure 4) and watch the progress via the 
data transfer progress bar. By ticking the “Select All Stations” or “Select All Elements”, you 
instruct the system to transfer data for all the stations and all elements if existing. 
 

 
Figure4 - Data transfer operation from "observationInitial” to “observationFinal” 
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3. External Data Transfer Operations 

These operations includes importing data from CLIMSOFT version 3, CLICOM, Automatic 
Weather Stations (AWSs) and NOAA GTS.  

3.1 Data migration 

During the process of data migration, data from Climsoft version 3 and earlier versions will be 
successfully imported into Climsoft version 4.This process is carried out as follows: 

Step1: Login into Climsoft as "administrator"; 
Step 2: Click on "Data transfer" icon located on the welcome form; 
Step 3: Click on "External Data" and select "Data Migration" from the drop down list (Figure 
5) to obtain the dialog in (Figure 6) below: 

 
Figure5 - External Data Transfer Dialog  
 
Step 4: The dialog below (Figure 6) is obtained after selecting Dtata Migration ption from the 
drop down list: 
 

 
Figure6 - Data Migration Transfer 
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There are 2 options to import data from Climsoft version 3 to Climsoft version 4 

3.1.1 Importing from Climsoft V3 MySQL Database 

This operation requires that the entire ClimsoftV3 database be available in MySQL script file 
e.g.: mysql_main_CLIMSOFT_database_v3.sql. 

To import such file into Climsoft version 4, follow the steps below: 
Step1: Launch MariaDB Prompt from your program "Start Menu", select and click on the 
"MySQL Client (MariaDB 10.x)" as shown below Figure7.  

 
Figure7 - Launching MariaDB Client 

 
Step 2: The dialog for entering the password should then appear as shown in Figure 8 below: 
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Figure8 - Entering password on MariaDB Client Prompt 

 
Step 3: Type correctly the password for "root". If you have entered the correct password i.e. 
the same password that you entered during the installation of MariaDB, the prompt should 
then appear as shown in Figure 9 below: 

 
 Figure9 - MariaDB Prompt after entering a correct password 

 
Step 4: Run the script: 
 
Assuming the database script file for creating the Climsoft version3 database in MariaDB 
database server is in the Path “C:\Backup_Data_SQL”.  
To run this script, what you need to do is to type the following command: 
“Source C:\Backup_Data_SQL\mysql_main_climsoftT_database_v3.sql” as indicated on the 
above prompt dialog and validate by pressing the "Enter Key" as shown (Figure10) below: 
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Figure10 - Indicating the computer path where the script file is located 
 
If you have typed the command correctly, the script should run successfully and create the 
Climsoft V3 database in MariaDB database server. If you wish, you can verify that Climsoft 
version 3 database has been created successfully by typing the following command on the 
MariaDB Client Prompt:"Show databases;" and press the "Enter Key". 

Afer creating Climsoft version 3 database in MariaDB database server,the next step is now to 
migrate data from Climsoft version 3 database to Climsoft version 4 database: 

To be able to migrate data from Climsoft version 3 to Climsoft version 4, you have to ensure 
both database exists in MariaDB database server (i.e.: mysql_main_climsoft_database_v3 
and mariadb_climsoft_db_v4). (Figure11); 

 
Figure11 – Importing mysql_main_climsoft_v3 into climsoft version 4 

 

The data migration from Climsoft version 3 to Climsoft version 4 will then be carried out in the 
following steps:  

Step1: Ensure the database names for both V3 and V4 are correctly typed in the right boxes; 
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Step2: Select the option Entire Database if the entire database is to be migrated; 

Step3: Select the option Selected Records if only a range of data is to be migrated and 
provide the starting and the ending years appropriately; 

Step4: Check the box Replace Existing Records if any existing similar records are to be 
replaced. If Unchecked the duplicate records will be skipped; 

Step5: Click Start command to start the process; 

Step6: Observe any message reported in the message box and address them accordingly. 

3.1.2 Importing from Climsoft V3 Backup 

Climsoft version 3 backups that are in comma separated values (csv) files are imported 
through the steps below (Figure12):  

Step1: Select the option CLIMSOFT V3 Backup; 

Step2: Through the explorer button select the text backup file. The file name is then displayed 
in the box Backup File and wait for the messages; CLIMSOFT 3 Backup converted to 
CLIMSOFT 4 Structure; 

Note: It is strongly recommended that the computer login user be the Administrator or 
members of the administrator to perform this task otherwise ,this user need to be granted the 
right permission on the ClimsoftV4 folder and subfolders to be able to perform this task (i.e.: 
read and write in the ClimsoftV4 folder . 

Step3: Check or uncheck the box Replace Existing Records appropriately; 

Step4: Click Start command to start the process; 

Step5: Observe any message reported in the messages box and address them accordingly. 

Figure12 - Importing backup csv CLIMSOFT version 3 data into CLIMSOFT version 4 
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4. Importing CLICOM data 

From this operation the 3 CLICOM data formats namely CLICOM Daily, CLICOM Synop and 
CLICOM Hourly will be imported into Climsoft version 4. 

Figure 13 shows a screenshot of sample CLICOM daily data. The data format is similar to that 
for CLIMBASE. Users with data from CLIMBASE can follow the same procedure to import 
CLIMBASE data into Climsoft. 

 
Figure13 - Sample CLICOM daily data 

 

To import CLICOM daily data, click on the “Data Transfer” icon on the Climsoft Welcome 
screen, followed by clicking on the menu items External Data ->CLICOM >Daily. This will 
open the dialog shown in Figure14 below.  

 
Figure14 - Importing CLICOM daily data 

 

Click “Open File” then select the file containing the data and click “Open” on the file open 
dialog. Enter the hour for the daily data observation in the text box “Default Observation 
hour” 06Z has been set as the default. Then from the import dialog click “View Data” and the 
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grid table gets populated with the data.  Confirm that it’s the right data then click “Load Data”. 
Wait for the process shown in Figure15 to complete with a message “Data import process 
completed”.  

CLICOM Synop and CLICOM Hourly data are similarly imported. 

 

Figure15 - CLICOM daily data import process 

 

Important: 

1. A folder for CLICOM data must be configured under the “General Settings”. This is used 
as a working area by the Climsoft application during the process of importing CLICOM data). 
If the MariaDB server is being accessed over the network from a workstation, it would be ideal 
to map that folder on the workstation for easy access or viewing from the workstation. 
However, the data to be imported can be placed in any location that is accessible via the 
“Browse” button. 

2. Since most data migrated from CLICOM has been noted to have numerous errors, data 
from CLICOM will be transferred to the “observationInitial” table so that the data can be QC’d 
before being transferred to the “observationFinal” table. 

 
Figure16 - Configuration of CLICOM data folder 
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5. Importing Automatic Weather Station (AWS) data 

Before importing AWS data, it is important to note the structure or format of the AWS data. 
Many Automatic Weather Stations (AWS) are configured to produce data output files in ASCII 
format. However, AWS from different suppliers tend to have different observation data outputs 
depending on the sensors available and configuration of the output. Figure17 shows a 
screenshot of sample data from an AWS installed in Rwanda. The first row contains the field 
column) headings representing different meteorological elements. In most cases, not all fields 
are required for data ingestion into the Climsoft database. 

Figure17 - Sample observation data from an AWS 
 

5.1 Selecting the import file and viewing data 

 

Procedures: 

(i) Select the “Data Transfer” Icon from the main menu welcome dialog; 
(ii) Select “External Data” from the Database utilities menu; 
(iii) Select “AWS” to open import dialog as shown in Figure18, 
(iv) Click on “Open File” to browse for the file to import; 
(v) After the file has been located, click “Open” in the file open dialog; the filename with its 

full path will then be shown in the Import File text box. See Figure18; 
(vi) Select the “Delimiter” option that matches the data separator in the selected file, selecting 

a wrong delimiter option will result in data not being properly imported; 
(vii) If some header rows are to be skipped while importing then, enter the row number where 

importing will start in the “Start Row” text box (Start Row: 2 is the default i.e. data starts 
at row 2 and row 1 contains the headers for the data columns); 

(viii) “Remove Scaling” is checked by default i.e. if the data in the file will be scaled to some 
decimal points then the decimal point will be removed during the transfer into 
“observationinitial” table. If the data in the file is not scaled to decimal points then the 
“Remove Scaling” box must be unchecked; 

(ix) If all the data belongs to one station and that it does not have a column with station IDs, 
then type the ID for the station in the “Station ID” text box.; 

After completing above steps click “View Data” to populate the grid view with the selected 
data. Note that only the first 25 rows of data from the selected file will be listed in the grid 
table. This is meant to enable confirmation that the right data has been selected. However, 
the entire file will be imported if everything is well selected. 
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Note that the column headers in the grid table will be serialized with numbers from 1 up to the 
last column of that data. 
The following section outlines how to rename the column headers with the element codes for 
the data they represent. 

 

 
Figure18 - AWS Data Import Dialog 
 

5.2 Configuring column headers and uploading data into Climsoft database 

(i) Under “Columns Header Settings” (see Figure 18 above), select the column number 
and click on the appropriate Field Name from the two boxes therein respectively. Do that 
for each column until all of them are done. Make sure the correct field names are selected 
in order for the data to be appropriately mapped in the database. If any column contains 
data that will not be imported it should be labeled “NA”, 

(ii) If the step (i) above is correctively completed then configured header specifications can 
be saved in a text file to be used later for a similar file without going through that process 
again. To save the specifications click “Save Header Specs” button and choose a 
convenient location and file. Note that the file will automatically be allocated file extension 
of sch e.g. aws1.csh; 

(iii) If the header specs had been saved earlier click “Load Header Specs” and select the 
header specs file. If correctly selected the columns in the displayed data table will be 
automatically labeled with the header specs. 

If satisfied that the columns are correctly named click “Load Data” to start the uploading 
process. Wait until the busy mouse pointer changes to default. A message will be displaying 
at the bottom of the dialog in red showing the data transfer progress. 
It should be noted that the Station IDs and Element Codes used must described in the 
metadata. If not data described by them will not be imported. Station IDs and Element Codes 
not found in metadata will be listed at the bottom of the dialog. 
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 Figure19 - Configuration of column headers 
 
 

Important 

1. A folder for AWS data must be configured under the “General Settings”. (Figure20).  This is used 
as a working area by the Climsoft application during the process of importing AWS data. That folder 
must be on the computer where the MariaDB is running from. If the MariaDB server is being accessed 
over the network from a workstation, it would be ideal to map that folder on the workstation for easy 
access or viewing from the workstation. However, data to be imported can be placed in any location 
that is accessible via the “Browse” button  

2. Data from AWS will be transferred into the “observationFinal” table. 

 

 
Figure20 - AWS data Configuration 
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6. Importing Text Files Data of Different Structures 

6.1 Hourly and Daily Data Import 

Daily/Hourly data values arranged in one or many columns can be ingested easily into Climsoft 
version 4. Data should be saved in delimited text files. Figure21 and 22 are sample data files 
with data organized in different structures: 
 

 
Figure21 - Sample file with data in one column 

 

 
Figure22 - Sample file with data in many columns 

 

Follow the steps below to transfer Hourly/Daily data with one or many columns structure into 
Climsoft version 4: 

(i) Select “Data transfer” icon from the welcome main menu dialog, 

(ii) Select “External Data” and select “Text Files” and then “Hourly or Daily” option, Figure 
23,  
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Figure23 - Importing External Data Dialog 
 

(iii) After selecting “Hourly or Daily” option, the dialog in Figure 60 displays. Click on “Open 
File“ to browse and select the file containing data to transfer, specify the “delimiter” of 
the file to import (e.g. comma (default), TAB, Others), tick/untick the “remove scaling” 
box appropriately to ensure data will be imported into “observationinitial” table without the 
decimal points and then select “View Data” to view the file in data sheet view (tabular 
form), 

(iv) Set the Columns Header by matching each data column by its corresponding field name, 

Figure24 - Importing External Data 

(v) After finishing the matching you will have the dialog shown in Figure 25. 
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Figure25 - Columns Header Settings 

 

(vi) Click the “Load Data” button to load the data into the “observationinitial” table and 
observe the records uploading count and the process completion message at the bottom of 
the dialog. In case the upload fails a message will pop up accordingly 

Note: To avoid setting the columns headers each time you load new data, save the columns 
header specifications by selecting the “Save Header Specs” button. Note the file extension 
(e.g. header1_specs.sch). To retrieve and use the saved columns headers select the ” Load 
Header Specs” button and navigate to select the appropriate file. 

 

6.2 Multiple Element Columns 

Figure26 shows  a text (csv) file (opened in Excel) with the columns for StationID, Year, Month, 
Day and 5 columns with values of different Elements (i.e. Tmax, Tmin, RAIN, RAD and EVAP). 
This file can be easily imported into Climsoft version 4 through the procedure described below: 
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Figure26 - Sample data with multiple columns 
 
 
The procedure to import this file is as follows: 

a) Selecting the import file and viewing the data 

(i) Select the “Data transfer” icon from the welcome dialog, 
(ii) Select “External Data”, then “Text Files” and then the “Multiple Element Columns” 

option (see Figure27),  
(iii) Select Open File to browse the file to import, 
(iv)  After the file has been located, click Open in the file open dialog; the filename with its full 

path will be shown in the “Import File box”. See Figure27, 
(v)  Select the Delimiter option according to the data separator for the selected file (comma, 

tab or others). 
(vi) If some rows are to be skipped while importing e.g. column headers enter the row number 

where importing will start in the “Start Row” box. Row 2 is the default, 
(vii) If the data does not contain the observation hour column, fill the “Default Observation 

Hour” box by entering the daily observation hour. The value 06 has been set as default 
as it is the case with most parameters, 

(viii) If the data in the file is scaled to some decimal point, then check the box Remove Scaling, 
(ix) When all the above steps have been completed click View Data. The table in the dialog 

is then populated with the data from the selected file. The column header will be serialised 
with numbers from 1 up to the last column of that data, as shown in Figure27. 
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Figure27 - Multiple column data Import 

 
b) Configuring column headers and upload data to the Climsoft database 
 
(i) Under “Columns Header Settings”, select the column number and click on the 

appropriate field name from the two boxes respectively. For the data columns the selected 
field name should be the element code for the data under that column. Repeat for each 
column. Make sure the correct field names are selected for the data to be appropriately 
mapped in the database, 

(ii)  Once step (i) is completed the created header specifications can be saved in a text file 
to be used later for a similar file without going through the same process again. To save 
the header specifications click “Save Header Specs” and choose a convenient location 
and file, 

(iii) If the header specs had earlier been saved in a file then click “Load Header Specs” and 
select the folder that contains that file. If correctly specified, the columns in the displayed 
data table are labelled automatically as shown in Figure28, 

(iv) Once the columns are correctly named click “Load Data” to start the uploading process. 
Wait until the busy mouse pointer changes to the default. A message is then displaying 
at the bottom of the dialog in red showing the data transfer progress. 

 

More details on the Command Buttons for the data import dialog are as follows: 

Save Header Specs - Click Save Header Specs to save the header specification as a file for 
future use; 
Load Header Specs - Click on Load header Specs to load the saved header specification into 
your data to avoid typing the headers each time; 
View Data - Click View Data to view the data in a table view; 
Load Data - Click Load Data to start the uploading process;  
Clear - Click Clear to remove all the data from the table; 
Close - Click Close to close the dialog;  
Help - Click Help to get more information on the dialog; 
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Figure28 - Multiple column data Import with column headers specification 

 

6.3 Importing Summarized Data 

Data that is summarized on Dekadal or monthly basis can be imported into Climsoft. In 

practice this is done when the raw data for those summaries is not available. Otherwise it is 

advisable to import the actual observations because Climsoft is capable of producing those 

summaries whenever required. 

 

After importing summarized values will be placed in the appropriate day of the month and be 

allocated a period value that is equivalent to the number of days used in the summary. For 

instance monthly summary values will be placed on the last day of the month and the period 

value will be number of days in that month. 

 

Following are examples of the summarized data with layouts: 
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Figure 29a Dekadal – Multiple Elements columns         Figure 29b Dekadal – Single Elements column 
 
 

 
 
 
       
 
 
 

Figure 29c Monthly – Multiple Elements columns   Figure 29d Monthly– Single Elements column 

 
The import procedures will differ with the layout of the summarized data as follows: 
 
a. Data in multiple Elements Columns - Figure 29a and 29c 

From Welcome dialog follow: 
Data Transfer -> External Data ->Text File->Multiple Element Columns.Then check 
option Dekadal or Monthly for type of Figure 29a or 29c respectively. 

 
b. Dekadal data in single Elements Column - Figure 29b  

From Welcome dialog follow: 
Data Transfer -> External Data ->Text File->Daily. Then check option Dekadal. 

 
c. Monthly data in single Elements Column - Figure 29d  

From Welcome dialog follow: 
Data Transfer -> External Data ->Text File->Monthly. 
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Notes on Daily Data Import 
 
Trace Rainfall – Should be typed as 0T 
Missing Data – Should be left as blank. Any value that is not numeric will be regarded as missing 
data 
Cumulated Data – Cumulated data should be type with C, e.g. 200C. Values for preceding days be 
left blanks. 

6.4 Upload failures 

Data upload may fail due to various reasons. Error messages will be given on each case. As 

much as possible the messages should be studied carefully and the problems describe therein 

be addressed. In case of station or element in the data that had not been defined in the 

metadata the affected records will be skipped and the stations/elements listed at the bottom 

of the import dialog. Data should therefore be corrected and reloaded.  

 

7. Importing GTS data downloaded from NOAA – NCDC FTP site 

The NOAA-NCDC FTP site has a huge archive of GTS daily observation data from all synoptic 
stations around the globe. Most of the data dates back to the early 1970s. The data goes 
through some QC at NOAA-NCDC and is updated on a daily basis. The data is publicly 
available in compressed format. Climsoft has a facility for ingesting the unzipped data from 
NOAA-NCDC. Figure30 below shows a screenshot of sample data downloaded from the 
NOAA-NCDC FTP site: 

Figure30 - Sample data from NOAA-NCDC 
 

To import GTS daily data from NOAA-NCDC; 

(i) Select “Data Transfer” icon on the CLIMSOFT Welcome screen,  
(ii) Select “External Data” menu; 
(iii) 3. Select “NOAA GTS” to open the dialog and browse the data file as shown in Figure31 

below. 
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Figure31 - Importing data from a text file downloaded from NOAA-NCDC FTP site 
 

NOTE:  

(i) A folder for GTS data must be configured under the “General Settings”. This is used as a working 
area by the Climsoft application during the process of importing the GTS data. If the MariaDB server 
is being accessed over the network from a workstation, it would be ideal to map that folder on the 
workstation for easy access or viewing from the workstation. However, the data to be imported can 
be placed in any location that is accessible via the “Browse” button. 
 

(ii) Since the GTS data would have gone through QC at NOAA-NCDC, the data is transferred to the 
“observationfinal” table. 

 

 

Figure32 - GTS-NOAA data Configuration 

 

Note: For any question or further clarifications, contact the CLIMSOFT Helpdesk: 
support@climsoft.org 
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